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Copyright
©1998 General DataComm, Inc. ALL RIGHTS RESERVED.

This publication and the software it describes contain proprietary and confidential informa
No part of this document may be copied, photocopied, reproduced, translated or reduced
electronic or machine-readable format without prior written permission of General DataCo
Inc. The information in this document is subject to change without notice. General DataCo
assumes no responsibility for any damages arising from the use of this document, includin
not limited to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions concerning this manual, please contact:

Technical Publications Department
General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut  USA 06762-1299

Telephone: 1 203 758 1811

Trademarks
All brand or product names are trademarks or registered trademarks of their respective com
or organizations.

Revision History

Safety Guidelines
• Always use the following guidelines when unsafe conditions exist or when potentiall

hazardous voltages are present:

• Always use caution and common sense.

• To reduce the risk of electrical shock, do not operate equipment with the cover remo

• Repairs must be performed by qualified service personnel only.

• Never install telephone jacks in a wet location unless the jack is designed for that loc

• Never touch uninsulated telephone wires or terminals unless the telephone line is 
disconnected at the network interface.

Table-1 Revision History

Issue Number Date Description of Change

01 July 1 1998 Applications for user interface
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• Use caution when installing telephone lines and never install telephone wiring during
electrical storm.

Antistatic Precautions
Electrostatic discharge (ESD) results from the buildup of static electricity and can cause com
components to fail. Electrostatic discharge occurs when a person whose body contains a 
buildup touches a computer component.

The equipment may contain static-sensitive devices that are easily damaged and proper h
and grounding is essential. Use ESD precautionary measures when installing parts or card
keep the parts and cards in antistatic packaging when not in use. If possible, use antistatic
floorpads and workbench pads.

When handling components, or when setting switch options, always use an antistatic wrist
connected to a grounded equipment frame or chassis. If a wrist strap is not available, periodically 
touch an unpainted metal surface on the equipment. Never use a conductive tool, like a 
screwdriver or a paper clip, to set switches. 

FCC Part 68 Compliance
Connection of data communications equipment to the public telephone network is regulate
FCC Rules and Regulations. This equipment complies with Part 68 of these regulations w
require all of the following.

For single or multi-line equipment that connects to the telephone network via a plug and jac
plug and jack must comply with the FCC Part 68 rules. This device is designed to be conn
to the telephone or premises wiring, using a compatible modular jack which is Part 68 comp
See installation chapter for details. 

If the unit causes harm to the telephone network, the telephone company may discontinue
service temporarily and if possible, you will be notified in advance. If advance notice is not
practical, you will be notified as soon as possible and will be advised of your right to file a 
complaint with the FCC. The telephone company may change its communication facilities,
equipment, operations and procedures where reasonably required for operation. If so, the
telephone company will notify you in writing. All repairs or modifications to the equipment m
be performed by General DataComm. Any other repair or modification by a user voids the
registration and the warranty.

The APEX DDS1 has a DSX-1 interface. To use the public telephone network, it must be 
connected to a registered CSU. 

To connect the APEX DDS1 to the public telephone network the customer is required to pr
the following information:

FCC Registration Number: AG6USA-23156-XD-N

Telephone Company jack type: Provided by the registered CSU. 

Facility Interface Codes:
T1 Interface - 04DU9-BN, 04DU9-DN, 04DU9-1KN, 04DU9-1ZN

Service Order Code:
T1 Interface - 6.0N
058R731-V300-01 GDC UAS 600
® 

 Team 600 for UNIX iii



                                           

 
nts as 
The 

 to the 
using 
 the 

e 

onnect 

power 
ether. 

act the 

s an 
rface. 
 the 
ceed 5.

ux de 
niques 
era à 

 
stallé 
ossible 
ervice 

igné par 
ncher 
use de 

 source 
y en a, 
ns 
Industry Canada Notification
The Industry Canada label identifies certified equipment. This certification means that the
equipment meets telecommunications network protective, operation and safety requireme
prescribed in the appropriate Terminal Equipment Technical Requirements document(s). 
Department does not guarantee the equipment will operate to the user's satisfaction.

Before installing this equipment, users should ensure that it is permissible to be connected
facilities of the local telecommunications company. The equipment must also be installed 
an acceptable method of connection. The customer should be aware that compliance with
above conditions may not prevent degradation of service in some situations.

Repairs to certified equipment should be coordinated by a representative designated by th
supplier. Any repairs or alterations made by the user to this equipment, or equipment 
malfunctions, may give the telecommunications company cause to request the user to disc
the equipment.

Users should ensure for their own protection that the electrical ground connections of the 
utility, telephone lines and internal metallic water pipe system, if present, are connected tog
This precaution may be particularly important in rural areas.

Caution: Users should not attempt to make such connections themselves, but should cont
appropriate electric inspection authority, or electrician, as appropriate.

Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provide
indication of the maximum number of terminals allowed to be connected to a telephone inte
The termination on an interface may consist of any combination of devices subject only to
requirement that the sum of the Ringer Equivalence Numbers of all the devices does not ex

Electromagnetic Compatibility

This Class A digital apparatus complies with Canadian ICES-003.

Avis D’industrie Canada
L’étiquette d’Industrie Canada identifie le matériel homologué. Cette étiquette certifie que 
le matériel est conforme aux normes de protection, d’exploitation et de sécurité des résea
télécommunications, comme le prescrivent les documents concernant les exigences tech
relatives au matériel terminal. Le Ministère n’assure toutefois pas que le matériel fonctionn
la satisfaction de l’utilisateur.

Avant d’installer ce matériel, l’utilisateur doit s’assurer qu’il est permis de le raccorder aux
installations de l’entreprise locale de télécommunication. Le matériel doit également être in
en suivant une méthode acceptée de raccordement. L’abonné ne doit pas oublier qu’il est p
que la comformité aux conditions énoncées ci-dessus n’empêche pas la dégradation du s
dans certaines situations.

Les réparations de matériel homologué doivent être coordonnées par un représentant dés
le fournisseur. L’entreprise de télécommunications peut demander à l’utilisateur de débra
un appareil à la suite de réparations ou de modifications effectuées par l’utilisateur ou à ca
mauvais fonctionnement.

Pour sa propre protection, l’utilisateur doit s’assurer que tous les fils de mise à la terre de la
d’énergie électrique, des lignes téléphoniques et des canalisations d’eau métalliques, s’il 
sont raccordés ensemble. Cette précaution est particulièrement importante dans les régio
rurales.
iv GDC UAS 600
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Avertissement: L’utilisateur ne doit pas tenter de faire ces raccordements lui-même; il doit a
recours à un service d’inspection des installations électriques, ou à un électricien, selon le

Avis: L’indice d’équivalence de la sonnerie (IES) assigné à chaque dispositif terminal indiq
nombre maximal de terminaux qui peuvent être raccordés à une interface. La terminaison
interface téléphonique peut consister en une combinaison de quelques dispositifs, à la seu
condition que la somme d’indices d’équivalence de la sonnerie de tous les dispositifs n’excè
5.

La Compatibilité d’ Eléctro-magnetique

Cet appareil numerique de la classe A est conforme a la norme NMB-003 du Canada.

Deutschland
Installations Anweisungen: Installieren Sie die Telefonleitungen nicht während eines Gewitte
Installieren Sie die Telefonleitungen nicht in einem feuchten Raum, auβer die Dose entspricht den
Vorschriften für Feuchträume. Berühren Sie unisolierte Telefonleitungen oder Einrichtunge
nicht, auβer diese sind vom Telefonnetz getrennt. Vorsicht bei der Installierung oder Änder
von Telefonleitungen. Achtung: Es gibt keine durch den Benutzer zu wartende Teile im Gerä
Wartung darf nur durch qualifiziertes Personal erfolgen.

EC Declaration of Conformity
We: General DataComm Limited

Molly Millars Lane
Wokingham, Berkshire RG41 2QF, United Kingdom

On behalf of: General DataComm Inc.
1579 Straits Turnpike
Middlebury, CT 06762-1299, U.S.A.

The products to which this declaration relates are in conformity with the following relevant 
harmonized standards, the reference numbers of which have been published in the Official J
of the European Communities;

Electromagnetic Compatibility

EN55022: 1994

Specification for limits and methods of measurement of radio interference characteristics o
information technology equipment.

EN 50082-1: 1992

Generic immunity standard Part 1 Residential, Commercial, and Light Industry.

Safety

EN 60950: 1995 A1 through A3

Low Voltage Directive relating to electrical equipment designed for use within certain volta
limits.
058R731-V300-01 GDC UAS 600
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Preface

Introduction
This manual describes how to operate the Team 600 2B1Q Network Manager. It assumes 
familiarity with HP OpenView and a working knowledge of 2B1Q DSL functions and operati

The Team 600 software is an HP OpenView application that employs the Simple Network. 
Management Protocol (SNMP) to configure and control the operation of GDC 2B1Q LTU/NT
Units. The units support DTE interface functions and provide 2B1Q capability on the Digital
Subscriber Loop (DSL). 

The information contained in this manual has been carefully checked and is believed to be e
reliable. However, as General DataComm improves the reliability, function, and design of th
products, the possibility exists that information may not be current.

If you require updated, or any other General DataComm product information, contact the ad
or number below or visit our web site at:  http://www.gdc.com

General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut 06762-1299  USA

Telephone: 1 203 758 1811
Toll Free: 1 800 794 8246

Service Support and Training
VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment.

GDC’s VITAL Network Services provides hands-on training courses through VITAL Network 
Services Global Technology Training Services. Courses range from basic data communication
modems and multiplexers, to complex network and ATM systems. Training courses are ava
at our centers in the US, UK, France, Singapore and Mexico, as well as at a customer’s site

For more information regarding GDC's VITAL Network Services’ service programs, training 
courses, or for assistance with your support requirements, contact GDC's VITAL Network Se
at the address or phone number listed below, or visit our website at:  http//www.vitalnetsvc.com

VITAL Network Services World Headquarters
6 Rubber Avenue
Naugatuck, Connecticut 06770  USA

North America: 1 800 243 1030
1 888 248 4825
1 203 729 2461

Training Information: 1 203 729 0271
058R731-V300-01 GDC UAS 600® Team 600 for UNIX P-1
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French Speaking Canada: 1 800 361 2552
North America Fax: 1 203 723 5012

1 203 729 7611

Safety Information
The DANGERS, WARNINGS and CAUTIONS that appear throughout this manual are not o
preventative measures designed to uphold the safety of both the service engineer and opera
also enhance equipment reliability.

The definitions and symbols for DANGER, WARNING and CAUTION comply with ANSI 
Z535.2, American National Standard for Environmental and Facility Safety Signs, and ANSI
Z535.4, Product Safety Signs and Labels, issued by the American National Standards Instit

The following examples show the symbols and definitions of DANGER, WARNING, CAUTIO
Note and Important as they are used in this manual.

VITAL Network Services Regional Sales and Service Offices:

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF  UK

Telephone: +44 1189 657200
Training: +44 1189 657240
Fax: +44 1189 657279

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico  D.F., Mexico

Telephone: +52 5 645 2238
Training: +52 5 645 2238
Fax: +52 5 645 5976

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore  238880

Telephone: +65 735 2123
Training: +65 735 2123
Fax: +65 735 6889

International Calling Code (+)
When calling from outside the country of origin, use the appropriate International Calling 
Code where the + symbol is shown.

Note Indicates a note. It is something you should be particularly aware of; something not readily 
apparent. A note is typically used as a suggestion.
P-2 GDC UAS 600® Team 600 for UNIX 058R731-V300-01
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Typographical Conventions

Level 1 Heading  paragraph headers introduce major topics. 

Level 2 Heading paragraph headers introduce subsections of major topics. 

Level 3 Heading paragraph headers introduce subsections of secondary topics. 

Courier font is used to show text that is displayed on the screen.

Times Bold font is used when referring to screen names.

Courier bold font is used to show specific input that you type at 
the keyboard.

Organization

This manual has six chapters. The information is arranged as follows:

• Chapter 1 - System Description describes the product and its features.

Important Indicates an emphasized note. It is something you should be particularly aware of; somethin
readily apparent. Important is typically used to prevent equipment damage.

CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in 
minor to moderate injury. It may also be used to alert against unsafe practices.

WARNING Warning indicates an imminently hazardous situation which, if not avoided, cou
result in death or serious injury.

DANGER Danger indicates an imminently hazardous situation which, if not avoided, will res
in death or serious injury.
058R731-V300-01 GDC UAS 600® Team 600 for UNIX P-3
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• Chapter 2 - Operation provides directions for accessing the individual applications that a
responsible for the Team 600 functions. It describes how to access the functions from 
map window menu bar, and from the Select menu of a data set front panel display. Th
chapter provides full descriptions of the Team 600 applications that display read-only 
windows. It provides access information for the applications that display read/write wind
and require greater operator interaction.

• Chapter 3 - Configuration provides instructions for accessing the Configuration applicati
and using it to set operating parameters in a selected data set. The chapter covers how
configuration changes to the unit or as templates at the controller workstation, and defin
parameters you can set.

• Chapter 4 - Maintenance provides instructions for accessing the Maintenance application 
using it to control functions of the data set.

• Chapter 5 - Diagnostics provides instructions for accessing the Diagnostics application 
window and using it to perform test procedures.

• Chapter 6 - Remote 600 Team Applications covers the applications of the remote 600s.

The Index contains topics on the Team 600 with page numbers.

GDC publication numbers are used to track and order technical manuals. Publication numbe
the following format:

GDC NNNRnnn-000 or GDC NNNRnnn-Vnnn

• NNN identifies the product family

• R denotes a technical publication

• nnn a number assigned by Technical Publications

• 000 identifies a hardware product and does not change

• Vnnn software version associated with a product, which may be updated periodica

The issue number changes when a manual is revised or reprinted with changes for some ot
reason; it does not automatically change when the software is updated. A new software ver
always Issue 1. Other specialized publications such as Release Notes or Addenda may be available 
depending on the product.

Glossary of Terms

2B1Q Code

2 Binary, 1 Quaternary code

Agent

A device or process running on a device or computer that responds to SNMP requests and se
SNMP Traps

GUI

Graphical User Interface

HP OpenView

HP based user interface for managing network applications and devices
P-4 GDC UAS 600® Team 600 for UNIX 058R731-V300-01
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A named collection of objects and their associated topology

MIB

Management Information Base The collection of object definitions that can be accessed throu
network management protocol

SCM

Shelf Controller Module

SNMP

Simple Network Management Protocol

UAS

Universal Access System

DSL

Digital Subscriber Loop
058R731-V300-01 GDC UAS 600® Team 600 for UNIX P-5
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Chapter 1: System Description

Overview

This manual covers the TEAM 600 Unix Application for HP OpenView. You should be famil
with HP OpenView and with the operation of SpectraComm Units (SCU) and DataComm U
(DCU) to use this manual effectively. 

The TEAM 600 Application is actually a collection of integrated applications for the HP OpenV
Network Management Platform. The applications use the Simple Network Management Pro
(SNMP) to manage GDC 600 SCUs. 

TEAM 600 applications enable you to:

• Configure 600 SCUs and DCUs. 

• Monitor the operation of the SCUs through displays of Alarms and DTE Interface States
through a Front Panel display that shows LED indicators as they appear on the front pa
the physical unit. 

• Diagnose suspected problems using local and remote loops (with or without an interna
generated test pattern). 

Basic Design

Here is a brief description of the basic design of the 2B1Q 600 series design.

UAS 2B1Q System Components

The UAS 2B1Q consists of the following components:

• SpectraComm 616

• SpectraComm 613

• SpectraComm 611

• DataComm 610

• DataComm 612

• DataComm 621

• GT 128

• SpectraComm Manager (SCM)
058R731-V300-01 GDC UAS 600®  Team 600 for UNIX 1-1
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SpectraComm 616 (SC616)

The SC616 is a six channel Line Termination Unit (LTU). The unit supports three 2B1Q U-
interfaces that are compatible with requirements of ANSI T1.0601-1992 and six co-direction
kbps interfaces that are compatible with the requirements of ITU-T G.703. Each 2B1Q U-inte
is permanently routed to a specific pair of G.703 interfaces. You may control the SC616 by a
via the SpectraComm management bus.

SpectraComm 611 (SC611)

The SC611 is a single-channel 2B1Q data transmission device. The unit supports ANSI T1.
1992 2B1Q U-interface and one ITU-T V.35 or EIA/TIA-232-E DTE interface (optionally, ITU
X.21 and EIA-530). The SC611 has a sub-rate capability (X.50) provided by the SC621.

SpectraComm 613 (SC613)

The SC613 is a three channel 2B1Q data transmission device. The unit supports three ANSI 
1992 2B1Q U-interfaces and three modified ITU-T X.21 DTE interfaces. Each 2B1Q U-inter
is permanently assigned to a specific X.21 interface port operating at either 64 or 128 kbps.

The SpectraComm SC616, SC611 and SC613 pass software configuration and control com
over the EOC (Embedded Operations Channel) from the SCM to a Remote 600 series tail c
As LTUs, the The SC616, SC611 and SC613 originate ANSI EOC B1 and B2 loopback comm
This allows the units to inter-operate with other (competitor) devices that comply with the AN
specification. The SC611 and SC613 are capable of responding to V.54 loopback control fro
U-loop as an enable/disable option.

DataComm 621 (DC621)

The DC621 is a low-cost Network Termination Unit (NTU). The unit complies with ANSI T1.6
1992 line coding requirements on the network side, and provides a DTE interface on the bu
equipment side. 

The line coding scheme is a 2B1Q as defined in T1.601. The DTE interface may be used to
compatible rate adaption is performed. The unit works with both synchronous and asynchro
DTEs. The basic DTE channel interface provided is ITU-T V.35 or EIA/TIA-232-E on card. 
Hardware hooks are provided for optional DTE interface types. Switches are provided for 
configuration but the unit will also respond to messages from the EOC.

DataComm 610 and 612 (DC610/612)

The DC610 and DC612 are single-channel and dual-channel Network Terminating Units (N
They are compatible with ANSI T1.601-1992 line coding requirements and support an opera
range of up to 18 kilo feet over a two-wire 26 gauge line.

V.35 and ITU-T V.24/V.28 interfaces are selectable by jumpers. Optional 530 or X.21 interfa
cards are available.

GT 128 (IDSL 128)

The GT 128 (IDSL 128) is a single-channel, Network Terminating Unit (NTU). It is compatib
with ANSI T1.601-1992 line coding requirements and supports an operating range of up to 1
feet over a two-wire, 26-gauge line.

V.35 and X.21 interfaces are selectable by jumpers. 
1-2 GDC UAS 600®  Team 600 for UNIX 058R731-V300-01
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SpectraComm Manager (SCM)

SpectraComm Manager (SCM) acts as the SNMP agent through which TEAM managemen
applications communicate with UAS 2B1Q components. All management communications a
directed to the SCM card Internet Protocol (IP) address. The SCM card relays commands a
responses between management applications and hardware components, using a slot addr
scheme to communicate over the SpectraComm shelf backplane with the other UAS 2B1Q 
components. The SCM is transparent to the applications, which operate as though they wer
communicating directly with the hardware units.

Theory of Operation
The TEAM Application Components are your gateway to the TEAM system which carries out
task while being user-friendly. All of the TEAM Controller application interfaces use the HP 
OpenView APIs (Application Programmer Interfaces) to integrate with HP OpenView Windo
and other network management applications. Menus are pulled down from the appropriate 
OpenView submap or are activated from the front panel button. The TEAM Controller GUI scr
meet HP OpenView premier partner requirements.

SpectraComm Manager Card and 600-Managed Units
The SpectraComm 600-managed units work with the GDC SpectraComm Manager (SCM) c
give you comprehensive network management using the Simple Network Management Pro
(SNMP). The SCM acts as the SNMP agent through which TEAM management applications
communicate with these 600-managed units and other compatible equipment. 

All management communications are directed to the SCM card Internet Protocol (IP) addres
SCM card relays commands and responses between management applications and hardwa
components, using a slot addressing scheme to communicate over the SpectraComm shelf
backplane with the other components. The SCM is transparent to the applications, which ope
though they were communicating directly with the hardware units. The SCM card is manage
the TEAM Core application, which is also responsible for the Discovery and Mapping function
which HP OpenView keeps track of the devices being managed. 

Accessing Team 600
The applications that make up the Team 600 manager are grouped on menus under the he
Performance , Configuration , Fault , and Misc  (Miscellaneous). Menus for the 
applications are available in two ways: 

• From the menu bar of the HPOV Map window when an 600-managed unit is selected 
window 

• From the Select  button on the 600 Front Panel display. 

600 front panel displays current status information on the 600-managed unit by displaying the
of the LED indicators on the front panel of the unit. The managed-unit has Select  button menus 
where you can access all other functions of the TEAM 600 manager. You can select the fron
from the Performance  menu in the HPOV Map window menu bar. You can also launch the fr
panel display from that window by double-clicking on the shelf icon of the unit or device you 
to work with.

The following TEAM 600 applications appear on both the Map window and Select  button 
menus:

• Performance : 

Alarms – furnishes detailed information about alarm state changes 
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Reports – displays statistical reports

• Configuration :

Configure – enables you to configure a selected 600 unit

Circuit Configuration - add or delete remotes

Maintenance – enables you to set device specific attributes that are not set as co
ration options

• Fault : 

Diagnose – lets you run diagnostic tests on a selected 600 unit

• Misc : 

Information – displays revision level information on the TEAM 600 software

The Misc  menu in the Map window menu bar offers you two selections that do not app
in the front panel Select  button menu: 

Front  Panel  Poll  Rate  – lets you set a default polling interval to be in effect ea
time the front panel display is opened. 

Note  Pad – opens a shell tool on the workstation running the TEAM software. Y
can use the shell tool to run a text editor, mail tool, or any other software that res
on the workstation. The note pad application is useful for keeping system record
1-4 GDC UAS 600®  Team 600 for UNIX 058R731-V300-01
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Chapter 2: Operations

Introduction

The Team 600 operates by giving you easy access to its fundamental tools when you run th
application. You can see how it constantly gives you feedback on status and alarms, allows
freedom to configure and maintain the application, and advises you of immediate testing res

Accessing 600 Application

The Team 600 controller application consists of a group of applications, each devoted to a s
aspect of controlling or monitoring 600 units. As mentioned in Chapter 1, you can access the Team
600 applications by:

• the map window menu bar, or

• the front panel window Select  button menus.

This chapter describes both ways.

Performance

There are four performance applications described in this chapter:

• Alarms  gives you alarm information in a read-only window.

• Reports  displays information on a variety of error conditions that may be experience
the unit over a 24-hour period.

• Front  Panel  displays the front panel of an unit. 

Configuration

Configuration  has three parts: Configure , Circuit  Configuration , and 
Maintenance . Each supports read/write windows so that you can review and change unit 
operating parameters. This chapter describes how to access Configure , Circuit  
Configuration  and Maintenance . Separate chapters are devoted to showing you how th
applications work. 

Fault

The Fault  menu lets you access Diagnose . With the Diagnose  application you can command
the test functions of the units and see the test results. This chapter describes how to access
Diagnose  application. A later chapter shows you how to use Diagnose . 

Misc
058R731-V300-01 GDC UAS 600®  Team 600 for UNIX 2-1
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Three items appear under the menu Misc  (miscellaneous): Information , Front  Panel  Poll  
Rate , Note  Pad, and Alarm Severity . Only Information  appears on the Select  button 
menu of the front panel display. 

Map Window Menu Bar Access

The table below illustrates how the Team 600 application functions are arranged on the me
at the top of the HPOV Map window and shows only the menu selections for the Team 600
applications. The map window menus include selections besides those that apply to Team 60
the window also lets you access other applications. You must select the unit you intend to wor
before you open the intended menu. Select the unit by clicking the mouse once on its icon i
shelf slot.

Note The menu item Agent Templates, which appears under Misc in the menu listing does not apply to S
based applications such as Team 600. The use of that function is therefore not documented in this m

Its functionality is employed by standalone Team application products such as Team 540 and Team
The Agent Templates function is documented in the manuals for those products.

Menu Bar Menu Selections

Performance

Front Panel...

Alarms...

Reports... 

Configuration

Configure...

Circuit Configuration...

Maintenance...

Fault

Diagnose...

Misc

Information...

Front Panel Poll Rate...

Note Pad...

Alarm Severity...
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The Performance menu Front  Panel  selection opens the front panel display window. The 
Select  button menus in the front panel display window include the selections that appear a
with the exceptions of Front Panel  under Performance, and Front Panel  Poll Rate  and 
Note Pad  under Misc .

Front Panel, 600
The 600 front panel display windows provide a graphical interface to a selected data set. To 
a front panel, choose the unit that you want to work with in the HPOV Map window. Then, e

• Select Front Panel  from the Performance menu for that window, or

• Double click the mouse on the icon for the selected unit if no remote units have been a

 

Front Panels, 610, 612, 621, and GT 128 for Remote Applications

The front panel remote status application lets you see the image of the face plate of the card
front panel of a 610, 612, 621, or GT 128 remote unit. 

The application is started by double clicking on the desired card slot icon on the Graphical 
Shelf Application  which then displays the Element Submap  (See Figure 2-1). Displayed 
in the Element Submap  is a 2B1Q master unit icon, shown connected to as many as three 2
unit icons. Figure 2-1 is an example of an Element Submap .

You have two ways to access a specific remote 600 unit front panel:

• Either (1) single click on one of the icons of the 600 remote units and then choose 
Performance->Front Panel ;

• Or (2) double click on one of the 600 remote unit icons in the Element Submap .

The front panel images (See Figure 2-2) represents LED images animated to reflect actual card
status. Offering you a summary of the real-time events that the unit is undergoing, this appli
gives you a convenient launching point for all the other major applications related to the 600 
products.

Note When viewing the shelf window, a square frame around the master unit status icon indicates that no 
remotes have been assigned.
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Figure 2-1 Element Submap (616) with the 600 Products as Remote Units
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Figure 2-2 Front Panel Series: 611, 613, or 616

LEDs of the Front Panels

The LEDs shown in a front panel display reflect the states of the actual indicators on the ph
unit (Table 2-1): 

Table 2-1 Front Panel LED Descriptions 

LED LED Indicates:

ON Power on.

SD Send Data, data is transmitted on channel.

RD Receive Data, data is received on channel. 

RS Request-to-Send on channel.

CO Carrier on channel.

ST Self-Test pattern is being transmitted.
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The application polls the unit to keep the states of the LEDs in the front panel display curren
time of the most recent poll appears in the bottom left corner of the front panel display. The t
displayed in white when Auto  Poll  is enabled and in yellow when it is disabled. LEDs are 
displayed as ON (bright green or bright red), or as OFF (dark green or dark red). In the case of erro
or a non-response, all LEDs are displayed in the off-state and an error footer message is dis

Buttons and Select Menu

The Select  button, at the bottom of the front panel displays, lets you access menus for the r
the Team 600 application functions. The following table, differing somewhat from the arrange
on the shelf map window menu bar, shows the arrangement of the Select  button menus 
(Table 2-2). 

RL Remote Loopback condition.

TM Test Mode is red if the unit is running a diagnostic 
test on the channel. 

LL1 , LL2 , LL3 Loopback condition is on the corresponding loop.

Table 2-2 Select Button Descriptions 

Select Menu Items Menu Selections

Performance

Alarms...

Reports...

Configuration

Configure...

Maintenance...

Fault

Diagnose...

Misc

Information...

Demand Poll

Polling status to update front panel

Table 2-1 Front Panel LED Descriptions  (Continued)
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Button Images on the Front Panel

Button images on the front panel are for display only (Table 2-3).

Polling

Two poll selections in the Select  button menu determine (for the current session) when the 
application is to collect new information from the unit to update the front panel window: 

• Demand Poll  which gives you an immediate display

• Auto  Poll  which enables you to select updates at 15, 30, or 60-second intervals or dis
automatic polling. 

Auto Poll
(Displays Off 
or poll inter-
val)

15 seconds

30 seconds

60 seconds

Off

Exit

Closes front panel application

Help  (button)

Displays help information

Table 2-3 Button Image Indications

Button Indication

LL Physical front panel Line Loopback test

ST Physical front panel Self Test

RL Physical front panel Remote Loopback test

GDC 
icon

Executes an information screen about the application

Table 2-2 Select Button Descriptions  (Continued)

Select Menu Items Menu Selections
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If you select Disable , the front panel window displays a static snapshot of the LED sta
as of their last poll: at the time the window was launched or a subsequent demand pol

Each time the front panel display is opened, its initial polling rate is determined by the front 
Poll Rate selection of the HPOV map window Misc  menu. 

Exit

The menu selection Exit  dismisses the front panel window when you click on it. 

All the front panel button applications are also available through HPOV pull-down menus on
Team 600 Shelf submap.

GDC Logo

The GDC logo on the front panel is actually a push-button which spawns off an informationa
screen containing Team 600 Controller version information.

Common Window Features

Each Team 600 application you select opens an on-screen window in which to operate. A n
of features are common to many of the windows (Table 2-4): 

Descriptions in this manual of the individual Team 600 applications identify window features
are specific to the applications, such as selections in the Menu bar and menus, and buttons

Performance Functions

The application gives you plenty of constant feedback on how the 600 units are operating. 

Alarms

Table 2-4 Common Features of the Team 600

Triangle
button
(Solaris)

Dot button
(HPUX)

Found in the title bar, which reduces the window to an icon when you click on it and select Close . 
Double-clicking on icon restores the window. This button appears on the top level window for e
application.

By clicking the dot button, you dismiss the window.

Title bar Identifies the specific Team 600 application running in the window. For example: Team 600 Ma
Configuration or Team 600 Diagnostics 

Menu bar Always contains the selections File , on the far left, and Help , on the far right. File  menu always 
contains the selection Exit , where you can dismiss the window. Some window File  menus contain 
selections particular for a window. Help  menu gives you information concerning the window. Some
windows have additional Menu bar selections. 

The Menu bar appears on the top level window for each application. A Menu bar appears in the 
Configuration window, for example, but not in the windows that you access from Main Configurat

Name field Identifies the 600 application that is currently connected to by displaying the user-configured s
name, followed by the SCU slot number, and the user-configured device name. 
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You can launch the Team 600 Alarms application from the Performance menu of the HPOV
window menu bar or from the front panel display Select button menu. The application displa
read-only Alarm  Detail  windows for the selected unit(s); illustrated are the Team 611 , 613 , and 
616  units (See Figure 2-3). The Team 600 application gets alarm indications from the unit in tw
ways: 

• Receiving traps sent automatically in response to alarm conditions at the unit. Or,

• initially, polling the unit for alarm conditions.

 

Figure 2-3 Alarm Detail Window (611, 613, and 616)

The following Alarm Detail window displays alarms for the 611, and 613, and 616 products. T
613 product gives you alarms for three loops and the 616 product displays alarms for the tw
channels within each loop as shown above (Table 2-5). 

Table 2-5 Alarm Detail Features 

Alarm Alarm Definitions

Out of Sync Indicates that framing on the U-loop signals has not been acquired (or has b
lost)

Sealing Current
No Continuity

Indicates that two-wire connection to the U-loop has not been detect
(or has been broken).

Tx Clock
Out of Tolerance

Indicates that the DTE supplied data clock is out of tolerance. This ala
is valid when optioned for external transmit clock timing.
058R731-V300-01 GDC UAS 600®  Team 600 for UNIX 2-9



Operations Performance Functions

 

d in a 
 
 

eatures 

(or 
 

bro-
Selectable Alarm Detail Window Items

The Alarm Detail window has selections File  and Help  in its menu bar, with the File  menu 
containing only one choice, Exit , which you click to dismiss the window. 

 Reports

You can launch the 600 report screens by selecting the HPOV Shelf Map slot icon and then
selecting the Performance->Reports  menu item; or you can click the front panel display 
Select  button. The first window called TEAM 600 Error Reports  you would see is the 
main window (Figure 2-4). 

Figure 2-4 Error Reports Window

It introduces you to each error category which has its own graph or statistics report, displaye
specific screen. Two kinds of reports are included: TOTALS and SUMMARY and each error category
is identified as ES, SES, and UAS. The menu cells on the TEAM 600 Error Reports screen are
File , Edit , View , and Navigate . Help  displays help information.

The error reports application is used to display statistics accumulated by the 600 unit. Some f
of the reporting function are:

• New background color (bisque) for graphs to emphasize graphical data

• Auto-ranging of Y-Axis

• X-Axis glyph labels lead to pop-up windows by pointing and clicking

• Real-time representation of the intervals

Ext Tx Clock
Not Present

Indicates that the DTE supplied transmit data clock has not been detected 
has been lost). This alarm is valid when optioned for external transmit clock
timing.

No DTR Present Indicates that the cable connection to the DTE has not been detected or is 
ken.

Major BER Incoming 600 bit error rate exceeds selected major alarm threshold
Major Alarm: on=orange, off=dark green.

Minor BER Incoming 600 bit error rate exceeds selected minor alarm threshold
Minor Alarm: on=yellow, off=dark green.

Table 2-5 Alarm Detail Features  (Continued)
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• Interval based graphs have scrolling capability to view all 24 hours worth of data

• Periodic polling for data

File

The menu item File->Refresh  is an on-demand update of the data. File->Auto Refresh  
has menu items to periodically poll the unit for data and update the screens. File->Auto 
Refresh->Off  disables periodic poll; any other option periodically refreshes at the selecte
value. Poll time is dynamically appended to the menu item File->Auto Refresh . File-
>Save Error Data to File...  saves the data to a file from the last poll. The data sav
in the file is in text format. The File->Exit  menu item closes all windows and terminates th
application.

Edit

The Edit->Reset  Statistics menu item sends an SNMP set to clear statistics in the unit an
clear data presented on the screen as well.

View

The View->Legend  displays any legend areas that exist for all the screens. The legend are
describes any notations used. For example, the main window has a legend area which cont
expansions for the acronyms ES, SES, and the other error categories.

Navigate

The Navigate  menu consists of several menu items to open other screens that are part of 
errors reports application. The screen pertains to the reports: 24 Hour Error Totals... , 
Errored Seconds... , Severely Errored Seconds... , Unavailable 
Seconds... , Errors Summary... , and All Screens... . 

Thus, the Navigate menu of the error reports window lets you access individual windows wh
show more detailed statistics on each error condition.

Interface Selector

The interface selection allows you to choose the interface for the report screens you want to 
(Loops 1, 2, and 3).

Error Totals

Error reports for the 600 product are given as data collection in intervals of real time. X-axis bu
of the graph represent data from error categories spread over 24 hours in 15-minute interva
is the same as using the Navigate menu for each error category.

No data is collected from the unit until File-->Refresh  is selected or the 
interface is changed.

NOTE
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Auto Ranging

This feature dynamically changes the Y-Axis scale, depending on the maximum value of any
error categories data on the X-Axis. If the value for an error category (or interval) is 100, the
Y-Axis maximum value is 100. When the X-Axis value for an error category changes to 500 t
Axis maximum changes to 500. This way, the graphs are more readable when the values for a
categories (or intervals) fall in the same range.

Loops

The statistics displayed for a TEAM 600 loop interface in the Error Reports window cover 24 h
of operation for a particular loop (Figure 2-5). You select which loop (Loop 1, 2, 3) that you wan
to view from the interface selection on the top level screen. The vertical axis of the 24-hour p
shows the number of errored seconds for the loop categories: ES (Errored Seconds), SES (S
Errored Seconds), and UAS (Unavailable Seconds). The 24 Hour Totals box on the right side
screen shows the totals of each category collected so far from the current 24 hours.   The 
Collection Period  box presents the portion of the current 24 hours collected so far displ
in number of intervals.

Also, the Errors Summary... button in the upper right hand corner is equivalent to the
Navigate-->Errors Summary menu item, which gives you a text summary of the valid interva
collected for all categories.

Figure 2-5 Twenty-Four Hours Total Screen

Errored Seconds (ES)

An errored second (ES) is defined as a second with at least one CRC error event. 
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Operations Performance Functions

ike 
f a 

 of the 
rvals. 
ast 24 

it has 
ou are 

e 

equal to 
h 12 

s 
ed after 
Figure 2-6 typifies the basic screen for individual statistical error categories, UAS and SES. L
all other graphs, the Y-Axis scale dynamically changes, depending on the maximum value o
certain interval. If data has been collected for less than 24 hours, the intervals on the X-Axis
graph are not displayed for the unavailable intervals. You have 97 vertical bar graphs of inte
This screen graphically shows the number of errored seconds that have taken place in the l
hours. 

The vertical axis of the bar graph displays error seconds for 15-minute time periods. If the un
not completed 24 hours of operation, then the unavailable intervals are not displayed. When y
finished with this screen, click on the Close button to dismiss the window. 

All Other Error Categories

All other error categories for the loop interfaces have similar screens and explanations as th
Errored Seconds does.

Figure 2-6 Errored Seconds Screen

Severely Errored Seconds (SES)

A Severely Errored Second (SES) is defined as a one-second period having greater than or 
30% errored frames or having one or more frames out of sync. A CRC is calculated for eac
millisecond frame. Thirty percent errored frames per second equals 25 CRC errors.

Unavailable Seconds (UAS)

Unavailable Time is the period of the Unavailable Seconds Signal (UAS) State. UAS state i
declared after the detection of 10 consecutive Severely Errored Seconds (SES), and is clear
a 10-second period with no SES. 
058R731-V300-01 GDC UAS 600®  Team 600 for UNIX 2-13



Operations Configuration Functions

e 
sented 
of error 

, then 
f op-
 a total 

u or 

hich 

d 
ration
Errors Summary

The Errors Summary screen is shown (Figure 2-7). It tabulates data on the error events that hav
occurred for each error category. The File-->Save Error Data to File option takes the data pre
on this screen and saves it to the user’s file. The Errors Summary screen displays an array 
events (Y-axis) plotted over time (X-axis).

• Loop Data

If the count of collected interval loop data is less than 97 (current plus 96 accumulated)
the remaining unfilled intervals are not displayed. Note, however, that after 24 hours o
eration, all loop intervals have data. The current box at the bottom of the screen shows
for each category and for the portion of the 24-hour period accumulated so far. 

Figure 2-7 Errors Summary Screen

Configuration Functions

Configure

You can launch the Team 600 Configure application from the HPOV Map Configuration Men
from the front panel menu. 

When you launch the application, it initially displays the Team 600 Configuration window, w
has a File  menu and a Navigate  menu in its menu bar. 

The File  menu contains the selections: 

• Refresh , which discards all unsaved changes and restores all options in the displaye
configuration windows to the values they are assigned by the current operating configu
2-14 GDC UAS 600®  Team 600 for UNIX 058R731-V300-01
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• Save to Unit , which puts the new configuration into use by the unit 

• Load Template , where you can recall a stored configuration template that you can t
save to the unit either with or without modifications 

• Save to Template , where you can store the current configuration on the workstation
future use as a template 

• Compare to Template , where you can identify differences between the configurati
displayed on-screen and a selected template 

• Exit , where you can dismiss the window. 

The Navigate  menu enables you to access the read/write windows where you can configu
various aspects of unit operation: 

• Unit Configuration 

• Alarms Reported 

• All Screens

The Team 600 Configure application is fully described in Chapter 3, Configuration. 

Maintenance

You can launch the Team 600 Maintenance application from the HPOV Map Configuration M
or from the front panel menu. 

The application displays one read/write window by which you can control some aspects of 
operation that fall outside the scope of the Configure  function. The Team 600 Maintenance 
application is fully described in Chapter 4, Maintenance. 

Diagnostics
You can launch the Team 600 Diagnostics application from the Shelf Map Fault Menu or fro
front panel display Select button menu. 

The application displays one read/write window by which you can control a variety of test func
on a selected unit. The Team 600 Diagnostics application is fully described in Chapter 5, 
Diagnostics. 

Miscellaneous Functions

Information

You can launch the Team 600 Information window by clicking on the GDC logo in a front pa
display. 

Information displays one read-only window that contains the name of the application, softwa
revision level information, and copyright information. The File  menu in the menu bar contains 
only the selection Exit , where you can dismiss the window.

Front Panel Poll Rate

You can open the Front Panel Poll Rate  window (See Figure 2-8) from the shelf submap 
Misc Menu . The setting you select in this window determines the initial polling rate for front pa
displays each time they are opened. 
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The rate selection is a global function. It selects initial polling rate for all front panel displays li
to a Team Core application, regardless of which individual application you access it from. 

There are four selections, each accompanied by a check-box: 

Slow  (60 seconds)

Normal  (30 seconds)

Fast  (15 seconds)

Demand Poll  Only  (Disable)

The File  menu in the menu bar contains two selections: Save to File  and Exit . 

To set the desired polling rate, first click on the appropriate check-box and then select Save to 
File  from the File  menu. Saving to file means that you are setting aside polling instruction
data for future us. The precise polling frequency that results from a setting of Slow , Normal , or 
Fast  depends on a number of factors. The higher the rate, the more communication and pro
capacity is devoted to maintaining the display. 

The polling rate for an individual front panel display can be changed for the duration of a se
by means of the Auto Poll  selection in the Select  button menu. Changes you make with tha
menu selection are not retained when the display is closed. 

To dismiss the window, select Exit  from the File  menu.

 

Figure 2-8 Front Panel Poll Rate Window

Note Pad

You can launch the Note Pad  application from the shelf submap Misc Menu . The application 
opens a shell tool on the workstation running the Team software. You can use the shell tool
a text editor, mail tool, or any other software that resides on the workstation. The Note Pad  
application provides this access for keeping records on the system.

Alarm Severity

Alarm Severity  lets you change the default severity of each alarm for the devices in a sh
For further information, refer to the TEAM CORE manual for a full description of this feature
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Chapter 3: Configuration

Introduction
The Team 600 Configuration application enables you to set all the options in an 600 unit thro
convenient group of configuration windows. 

You can start the Team 600 Configuration application by either of two methods: 

• Select a SCU symbol on the shelf submap in OpenView , then select the Configure  option 
from the Configuration  menu. 

• Click on the Select  button of the Front Panel display, then click on Configuration  and 
select Configure  from the resulting menu. 

Templates
You can store configuration settings as templates on the workstation that runs the Team 60
application. A template stores a configuration for the unit options, and you can store as man
templates as you need. 

To load configuration settings from a template into a unit you must perform the following ste

1. Select Load  Template  from the File  menu and select the template from the resulting
dialog window. The application retrieves the configuration settings of the selected temp

2. Select Save  to  Unit  from the File  menu. The application makes the template 
configuration settings the current operating configuration for the unit.

Configuration Procedure
The following steps describe how to use the configuration application, and illustrate the func
of the Main  Configuration  window menus. 

1. Access the Main  Configuration  window, either from the submap or from the Front 
Panel display. The application reads the current configuration from the unit when you 
the main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the unit continues to operate using its unch
current configuration. 

The Refresh  selection on the main window File  menu causes the application to read th
current configuration from the unit. All changes to any configuration windows that have
previously been saved to the unit or to a template are lost when you select Refresh . 

2. To edit the current configuration of the unit, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 
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3. Click on the Navigate  button to display a menu of the configuration windows, and sel
the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. Click the mo
on the value you select. When you change the value or setting of an option, the applic
displays the option name and the new value in white, rather than black, type. They rem
white until you either save the changes to the unit or a template by means of the Main  
window File  menu, or restore the option to its last stored value or setting. 

You can discard changes to a configuration window and return all its fields to their store
ues in two ways:

• Click on the Reset  button to discard changes while keeping the window open

• Click on the Cancel  button to discard changes and close the window. 

You can close a configuration window without losing changes by clicking on either theOK 
button or the push-pin glyph, which is located in the upper left corner of the window.

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The main configuration 
dow remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made al
your changes, click on the File  menu button of the Main  Configuration  window. 
From that menu you can select Save  to  Unit  to save the new configuration in the unit, o
select Save  to  Template  to save it as a template in the workstation. 

6. When you select Save to Unit, the changed configuration becomes the current configu
for the unit you are configuring. 

7. When you select Save  to  Template , a window appears containing a list of existing 
templates and a field for entering a new template name. You can select an existing tem
to be overwritten with the new configuration, or enter a name to create a new template
stored template is available to be loaded by the application and then saved, with or wi
further modification, to any unit of the same type. 

Configuration Option Values

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. 

Main Configuration Window

The Main  Configuration  window (Figure 3-1) has two pull down menus, File  and 
Navigate , that are the means by which you carry out the actual process of configuring the
selected unit. From the Navigate  menu you select the individual configuration windows in whic
you make changes. The File  menu commands the storage and retrieval of configuration settin
The contents of the two menus appear below. 
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The Main Configuration window title bar displays the application name, Team 600 (changes to
of unit selected) Configuration. The main body of the window has items that point out the se
unit and furnish information about its operations. Below, we have the Team 600  Configuration  
main window (Figure 3-1) which is launched from the HPOV Shelf Map Configuration Menu. T
application is made up of one main window and a set of transient windows giving you unit 
optioning, described below.

Figure 3-1 Main Configuration Windows for the 611, 613, and 616

Specifically, this main window has four areas:

• Title bar, providing application name

• Menu bar, providing file operations, navigation through subordinate screens, and basi

• Main body, providing administrative read-only fields

• Status messages, footer area, providing application data on activity and unit interactio

Details of this window (Figure 3-1) follow.

Menu Buttons Menu Selections Description Further
Selections

File

Refresh All options are read from the unit and outstanding 
edits are lost.

Save to Unit All outstanding edits are sent to the unit.
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Unit Configuration Options
The Team 600 Unit  Options  window (Figure 3-2) lets you define unit interface characteristic
for the unit. This screen is presented when you choose Navigate-->Unit Configuration  
Options  on the 600 configuration main window.

Load Template Allows you to select an existing 600 template to be 
applied as edits to the current application. Your next 
File-->Save  to  Unit  implements the template 
changes.

dialog window

Save to Template Configuration data is saved as a specific template. dialog window

Compare to Template You can select an existing 600 template to be com-
pared with the screen display.

dialog window

Exit Terminates application with outstanding edits dis-
carded first.*

*Note: If the configuration application is exited while pending edits exist on the configuration screens, you 
are prompted that Pending edits exist, do you want to save or exit without 
saving the changes?

Navigate

Unit Configuration... Unit  Configuration  Options  window.

Alarms Reported... Displays the Team 600
Alarms  Reported/Thresholds  window.

All Screens... Displays all subordinate windows of the application

Help Displays Help  screen.

Menu Buttons Menu Selections Description

Fields
(Read-Only)

Name This is the shelf name, identified by slot number and symbol label.

Slot State Gives you the state of the shelf slot, either as Active  or Inactive .

Operational Status Shows you the state of the current unit, either as Up or Down.

Serial Number Presents the serial number of the unit.

Firmware Revision Shows latest firmware revision on the unit.

Mib Version Shows mib version of the unit.

DTE Card Type Plug-in DTE Card Type (Unit 611 only)

Menu Buttons Menu Selections Description Further
Selections
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Figure 3-2 Team 600 Unit Options Windows for the 611, 613, and 616 Units

Figure 3-2 shows you the configuration windows for all three 600 products that allows you to
configure unit options, such as described below. Name is the shelf name, slot, and symbol label o
the selected slot symbol from the shelf map and is a read-only field. It appears with the sam
designation on all other subordinate screens.
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611 Unit Options Description

DTE

DTE Rate In Kbps: 2.4, 4.8, 9.6, 19.2, 48, 64, and 128

Rate Adaption X.50 Div3, X.50 Div2

Data Mode

DTE Operation Sync, Async

Over Speed 1.0%, 2.3%

Word Length 8 Bit Word, 9 Bit Word, 10 Bit Word, and 11 Bit Word

Tx Clk Source Internal , External

RTS/CTS

RTS Normal, Forced

Inband RTS Enable, Disable

RTS CTS Delay No Delay, Delay

Remote Loop

V.54 RDL Enable, Disable

RDL Timeout None, 10 Minutes

FP RDL Method V.54, EOC

613 Unit Options: Loops 1, 2, and 3

Tx Clk Source Internal , External

DTE Rate In Kbps: 64 and 128

V.54 RL Enabled, Disabled

V.54 RL Timeout No Timeout, 10 Minutes

616 Unit Options: Loops 1, 2, and 3

Master TX Clock Source External Clock 1, External Clock 2

Note: If DTE operation is Async , then TX Clk  Source  is grayed out. If DTE operation is Sync , then 
Over  Speed  and Word Length  is grayed out. 

Defaults in bold print.

Action Buttons

OK Dismisses the windows with edits retained. Same function as the mou
click-on, pin-pull.

Reset Undoes pending edits since last the File-->Save to Unit .

Cancel Same as Reset , it dismisses the screen.
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Alarms Reported
The Team 600 Alarms  Reported  window (Figure 3-3) lets you designate the alarms that are 
be masked (not reported) or unmasked (reported). This screen is shown when
Navigate->Alarms Reported  is selected on the 600 Configuration main window. This 
screen lets you configure alarm reporting. Note that unit default values for all alarm masks a
reported.
058R731-V300-01 GDC UAS 600®  Team 600 for UNIX 3-7



Configuration Alarms Reported
Figure 3-3 Team 600 Alarms Reported Window for the 611, 613, and 616 Units
3-8 GDC UAS 600®  Team 600 for UNIX 058R731-V300-01



Configuration Alarms Reported

r 

m 

ct-

ct-

 or 

r 

m 

ct-

ed 
611 Alarms Description

Out of Sync Indicates that framing on the U-loop signals has not been acquired (o
has been lost).

Tx Clock Out OF Tolerance Indicates that the DTE supplied data clock is out of tolerance. This alar
is valid when optioned for external transmit clock timing.

External Tx Clock Not Present Indicates that the DTE supplied transmit data clock has not been dete
ed (or has been lost). This alarm is valid when optioned for external 
transmit clock timing.

Sealing Current No Continuity Indicates that the two-wire connection to the U-loop has not been dete
ed (or has been broken).

No DTR Present Indicates that the cable connection to the DTE has not been detected
is broken.

Major Alarm BER Received bit error rate exceeds selected major alarm threshold.

Minor Alarm BER Received bit error rate exceeds selected minor alarm threshold.

Major BER Threshold Refer to Threshold Values for Determining Major/Minor A larms below.

Minor BER Threshold Refer to Threshold Values for Determining Major/Minor A larms below.

613 Alarms, Loops 1, 2, and 3

Out of Sync Indicates that framing on the U-loop signals has not been acquired (o
has been lost). 

Tx Clock Out OF Tolerance Indicates that the DTE supplied data clock is out of tolerance. This alar
is valid when optioned for external transmit clock timing.

External Tx Clock Not Present Indicates that the DTE supplied transmit data clock has not been dete
ed (or has been lost). This alarm is valid when optioned for external 
transmit clock timing.

Sealing Current No Continuity Indicates that two-wire connection to the U-loop has not been detect
(or has been broken).

Major Alarm BER Received bit error rate exceeds selected major alarm threshold.

Minor Alarm BER Received bit error rate exceeds selected minor alarm threshold.

Major BER Threshold Refer to Threshold Values for Determining Major/Minor A larms below.

Minor BER Threshold Refer to Threshold Values for Determining Major/Minor A larms below.

Threshold Values for Determining Major/Minor Alarms

1E-04
(default for major alarm)

1 x 10-4 bit error rate, threshold = 1 x 10-4, i.e.,
bit error rate exceeds 1 x 10-4--maj/min alarm declared 

1E-05 1 x 10-5bit error rate, threshold = 1 x 10-5, i.e.,
bit error rate exceeds 1 x 10-5--maj/min alarm declared 
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1E-06
(default for minor alarm)

1 x 10-6 bit error rate, threshold = 1 x 10-6, i.e.,
bit error rate exceeds 1 x 10-6--maj/min alarm declared

1E-07 1 x 10-7 bit error rate, threshold = 1 x 10-7, i.e.,
bit error rate exceeds 1 x 10-7--maj/min alarm declared

1E-08 1 x 10-8 bit error rate, threshold = 1 x 10-8, i.e.,
bit error rate exceeds 1 x 10-8--maj/min alarm declared

616 Alarms, Loops 1, 2, and 3

Out of Sync Indicates that framing on the U-loop signals has not been acquired (o
has been lost). 

Ch1 Tx Clock Out OF Tolerance Indicates that the DTE supplied data clock for Channel 1 is out of tole
ance. This alarm is valid when optioned for external transmit clock tim
ing.

Ch2 Tx Clock Out OF Tolerance Indicates that the DTE supplied data clock for Channel 2 is out of tole
ance. This alarm is valid when optioned for external transmit clock tim
ing.

Ch1 Tx Clock Not Present Indicates that the DTE supplied transmit data clock for Channel 1 ha
not been detected (or has been lost). This alarm is valid when option
for external transmit clock timing.

Ch2 Tx Clock Not Present Indicates that the DTE supplied transmit data clock for Channel 2 ha
not been detected (or has been lost). This alarm is valid when option
for external transmit clock timing.

Sealing Current No Continuity Indicates that two-wire connection to the U-loop has not been detecte
(or has been broken).

Action Buttons

Report All Selects all alarms for reporting.

Report None Deselects all alarms, no alarms reported.

OK Dismisses the windows with edits retained. Same function as the mou
click-on, pin-pull.

Reset Undoes pending edits since last the File-->Save to Unit .

Cancel Same as Reset , it dismisses the screen.
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Circuit Configuration
This screen is shown when Configuration->Circuit Configuration  is selected on the 
Shelf Map menu or from the front panel select button. This screen allows adding or deleting
remotes.

Add Remote/Delete Remote

This screen is shown when Navigate->Add Remote  is selected on the 600 Configuration mai
window (Figure 3-4). This screen provides a mechanism to add a dedicated remote to the 600
The Display  (text box) area displays the Loop Number , Unit Type , and the Serial 
Number of the unit.

Figure 3-4 Team 600 Add Remote or Delete Options Window

Unit Options Description

Name Shelf name, slot, or Symbol Label  of the selected slot symbol from the shelf map.

Serial Number This is the serial number of the remote unit to be added. User inputs this field.

Unit Type This is the unit type menu where the user selects type designating remote to be added

Loop Number Loop number is the main selection option. Unit type and serial number always correspo
with the selected loop number.

File->Refresh Causes the screen data to be refreshed from the SCM node table.

File->Exit Exits application and dismisses window.

Action Buttons

Add Remote Used to add a remote once a location and serial number have been entered.

Delete Remote Used to delete a remote once a remote has been selected from the list.
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Chapter 4: Maintenance

Introduction
The Team 600 Maintenance application provides a group of functions for controlling the ope
of a 600 device.

You can start the Team 600 Maintenance application by either of two methods: 

• Select a 600 unit symbol on a submap in OpenView , then select the Maintenance  option 
from the Configuration  menu. Or, 

• Click on the Select  button of the Front Panel display, then click on Configuration  and 
select Maintenance  from the resulting menu. 

Maintenance Window Buttons
The Maintenance  window (Figure 4-1) has four action buttons on the figure below.

Figure 4-1 Maintenance Window

Note The TEAM 600 Maintenance  application is a GUI screen which provides selections for options tha
are considered transitional and are not included in the configuration screen.

Menu Buttons Menu Selections Description

File

Exit Terminates application with outstanding edits discarded.
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Reset Statistics Loops

Featured in Figure 4-2 is the window for the TEAM 600 Maintenance Reset Statistics . 

Figure 4-2 Maintenance: Reset Statistics Loops Window for the 613 and 616 Units

Menu

Action Buttons Description

Reset to Factory Defaults Initiates a reset to default configuration parameters.

Perform Soft Reset Initiates a board reset and disrupts data transfer.

Inhibit/Enable Front Panel Inhibits or enables front panel push-buttons.

Reset Statistics Resets all statistics to zero for that unit or loop.

Note: Selecting Reset to Factory Defaults  for the 600 remotes causes the remote unit to become deleted fr
the Configuration--> Add/Delete Remote  screen on Team 7616, 7626, 7624, 616, 613, or 611; thus, 
communication to the remote unit would be lost.

Action Buttons Description

OK Activates selections and dismisses the window.

Cancel Dismisses the screen.
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Chapter 5: Diagnostics

Overview
The Diagnose  menu provides access to the Team 600 Diagnostic screen, which provides t
command and results display functions for all tests you can perform on the DSU by means 
TEAM application. The diagnostics window displays the results of the most recent test until 
begin another one. 600 Diagnostics  is launched from the Shelf Map Fault Menu . The 
application is made up of one main window and a transient window, giving you testing histo
which is called the Diagnostics History  screen. It is accessible from the main 
Diagnostics  window and displays the results of all tests performed during the current ses

The tests you can do from the Diagnostics  window are divided in two categories: Master 
Tests  and Master-Remote Tests . When using the diagnostic functions, refer to the 
appropriate 600 Installation and Operation Manual. 

Diagnostics Window
The Diagnostics  window (Figure 5-1) is broken down into three different areas: operations
navigation through subordinate screens, and basic help, identified as File , Navigate , and 
Help . The only selection in the file menu is Exit  for dismissing the application. The only 
selection in the Navigate menu is History , which causes the application to display the 
Diagnostics History  window (Figure 5-1) holding the results of all tests done during the
current session.

Diagnostic test fields, test control buttons, graphic displays (test diagrams), test results, and
messages make up the main part of the window. Status reports or messages give the viewe
date data on the application.
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Figure 5-1 Team 600 Diagnostics Window for the Unit 616

Menu Buttons Menu Selections Description

File

Exit Terminates application.

Navigate

History... Displays the 600 Diagnostics
History  window

Help Displays Help  screen.
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Menu Buttons Menu Selections Description

Fields

Name This is the shelf name, identified by slot number and symbol label (read
only).

Diagnostic Test

Interface Loops 1, 2, or 3

Channel Channel A or Channel B

Test Pattern Pattern 2047 or 511

Test

Self Test Initiates test pattern generations and checking.

Local Bi Loopback Local Bilateral Loopback places the master in digital and channel loop-
backs.

Rmt Chnl
Loopback

Remote Channel Loopback places the remote in channel loopback, loop
data received from the DTE back out to the DTE.

Rmt to Rmt ST Remote to Remote Self Test. Activates the test pattern generator and c
er in the selected remote unit, which then transmits its test pattern to the
master unit. For this test to provide useful results, it must also be comma
ed in a second remote unit: the one the first remote communicates with 
the far side of the public network. Once both remotes have been comma
ed to perform this test, each receives the test pattern transmitted by the o
and checks it for errors.

Rmt Digital
Loopback

Remote Digital Loopback directs the master to place the Remote 1 Digi
Loopback, looping data received from the U-Loop back out to the U-Loo

Rmt Bi Loopback Remote Bilateral Loopback places the remote in digital and channel loo
backs.

Rmt Bi Loopback 
with Self Test

When the remote line loopback is connected, the data received by the r
mote module from the local is returned by the 600 system module on the
ceive path, within the remote’s equipment interface. Therefore, during 
normal operation the local equipment should receive its own signal witho
errors. The local transmit signal is passed to the remote equipment conn
ed to the 600 system, however, the signal transmitted by the remote is l

Remote line loopback is generally used to test the proper operation of th
600 link end-to-end, and therefore should be used after normal operation
obtained while the remote 600 loopback is connected.

RDL with Self Test Remote Digital Loopback with Self-Test performs remote digital loopba
and places the master in test pattern generation and checking.

Mst to Rmt
Self Test

Master to Remote Self-Test places the master and remote in test pattern 
eration and checking.
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Test Instructions

Do the following steps to carry out test: 

1. Select the test to be done by clicking on the check box to the left of its name. 

2. Click on the Start  Test  button. The data path display panel exhibits the path for the t
you have selected, the Test  Status  field changes from Idle  to the test name. 

3. If you are running a Self  Test , the Reset  Bit  Errors  button is available while the test
runs. The reset button returns the error count to zero. The Stop  Test  button is available 
during any test. 

While running a test, the application displays the results in the Test  Results  window area.

Diagnostics History, 600

The diagnostics history application is used to log test information after the test is terminated
see the diagnostics history when you choose Navigate->History  on the 600 
Diagnostics  main window. Results of diagnostics tests for a current session are shown to
(Figure 5-2).

Test Buttons Description

Start Test Pressing this button starts the test selected in the menus.

Stop Test Pressing the button sends commands to stop all tests running in the unit.

Reset Errors This button enables you to reset errors to 0 on the master unit individually.

Graphical
Display Area

This area contains a graphical representation of the selected 600 and its interface to the she
network. Arrows show the current data paths and are changed to show the loopback paths se
for each test.

Test Status Displays the status of the diagnostic test. The following are displayed:

Test Results Displays the test results in bit errors. Only displayed for tests when the Pattern Generator  is 
on.

Note The Team 600 application polls the unit every 35 seconds while the Diagnostics window is open. In 
to reduce unnecessary LAN traffic, the Diagnostics window should be closed when it is not in use.

Idle Local Bi Loopback Rmt to Rmt ST Rmt Digital Loopback

Rmt Chnl Loopback Rmt Bi Loopback Self Test Mst to Rmt Self Test

RDL with Self Test Rmt Bi Loopback with Self Test
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Figure 5-2 Team 600 Diagnostics Window

Fields (Read-Only) Description

Name Shelf name

Start Time Date and time the test started

Test The specific test done

Pattern Test pattern selected (511 or 2047)

Test Time Total time elapsed since the test started: 
hours:minutes:seconds format

Test Results OK : for a test that does not involve Selftest, or for
a test with Selftest where no errors occurred

Bit Errors : followed by a bit error number 
for a test with Selftest where errors were found.

Action Buttons

OK Dismisses the screen.
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Chapter 6: Remote 600 Team Applications

Overview for the Remotes: 610, 612, 621, and GT 128
This chapter describes the TEAM 600 applications for the UAS remote devices, specifically:
612, 621, and GT 128, which we refer to as the remote units or Remotes in this chapter. Gra
User Interface (GUI) windows are part of the description. The UAS manager applications are
on the HP OpenView network management platform. HP Open View provides the framewor
the user interface application and the SNMP protocol for the communications framework. Th
units are remote units linked to the UAS 7616, 7626, 7624, or SC 600 series (611, 613, and 
the SpectraComm Shelf.

Communications
UAS uses Simple Network Management Protocol (SNMP) to carry out configuration, mainten
status, and other functions on the SCM and cards of the remotes. The IP (Internet Protocol)
addressable SCM is an SNMP agent that proxies requests to the other cards in the Spectra
Shelf. Alarms from the devices are sent to the HP OpenView Manager via SNMP Traps. Th
Manager furnishes the protocol stack for the SNMP Communications.

User Interface
The Graphical User Interface for the UAS remotes (600 Management) consists of several 
applications that are integrated to run under HP OpenView. The applications are summarize

• Front Panel

• Configuration

• Alarms

• Reports

• Maintenance

• Information

The following are GUI screens for the UAS remotes which are integrated into HP OpenView
application windows presented deal specifically with the 600 family products. The Graphical 
and SCM applications are handled as core functionality across the SpectraComm products 
not presented in this manual.

Front Panels, Remote Applications

The front panel status application lets you see the image of the face plate of the card for the
panels of the remote units. 

You begin this application by double clicking on the 7616, 7626, 7624, (or SC 600 series 611
and 616) card slot icon on the Graphical Shelf Application  and immediately shown to 
you is the Element Submap . Arrayed in this Element Submap  is a 7616, 7626, 7624, or SC
600 series (611, 613, and 616) unit icon, shown connected to as many as six 600 remote uni
Figure 6-1 is an example of an Element Submap .
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You have two ways to access a specific 600 front panel: either (1) single click on one of the
of the 600 remote units and then choose Performance->Front Panel ; or (2) double click on 
one of the 600 remote unit icons in the Element Submap .

The front panel image (See Figure 6-2) represents LED images animated to reflect actual card 
status. Offering you a summary of the real-time events that the unit is undergoing, this appli
gives you a convenient launching point for all the other major applications related to these 6
series products.

Figure 6-1 Element Submap (7616) with the 600 Products (Remote Units)
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Figure 6-2 Remote Front Panels

The GDC icon executes an information screen about the application. Table 6-1 defines illuminated 
LEDs for the remote front panels.

Table 6-1 Remote Front Panels LEDs 

LED Displayed LED Function

ON Power is on, indicated by bright green.

SYNC Unit is in sync with the 611, 613, 616, 7616, 7624, and 7626.

SD Send Data means data transmission on channel.

RD Receive Data indicates receiving data on channel.

RS Request-to-Send on channel

CS Clear-to-Send on channel

CO Carrier on channel

TM Test Mode indicates unit is running a diagnostic test on the channel.
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Buttons for the remote front panels are identified in Table 6-2.

Button images for the remote front panels (display only) are identified in Table 6-3.

CH (612 only) Shows which channel is active, CH1 or CH2.

LL  (GT 128 only) Local Loop is bright red while the unit is in a local loop, initiated from the
front panel push buttons.

ST (GT 128 only) Self Test is bright red while the unit is in a self test, initiated from the fron
panel push buttons.

RL (GT 128 only) Remote Loop is bright red while the unit is in a remote loop, initiated from
the front panel push buttons.

Table 6-2 Remote Front Panel Buttons

Button Button Function

Help Selects front panel descriptions

Select Contains a menu with selections for:

• Performance Alarms, Reports

• Configuration Configuration, Maintenance

• Misc Information

• Demand Poll Polling of status to update the front panel

• Auto Poll Periodic polling of status to update the front panel at 15, 30, or 60-seco
rates

• Exit Closing the front panel application

Table 6-3 Remote Front Panel Button Images

Button Button Function for Physical Front Panel

LL Line Loopback test

ST Self Test

RL Remote Loopback test

DL Data Loopback test

SEL Toggle between the DTE channels for diagnostic test (612 only).

Note: GDC icon executes an information screen about the application.

Table 6-1 Remote Front Panels LEDs  (Continued)
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Status Message Area

The status message area displays messages which describe application activity and unit inte
Examples are: time, not responding, etc.

Configuration of Remotes

The Graphical User Interface for the Configuration Application incorporates features for optio
the remote products. With the Configuration Application, you have access to unit level param
via the SNMP queries when Windows are displayed or refreshed. Through SNMP set comm
modifications are applied to the unit. The configuration application has templates for copyin
same configurations to other units. Configuration templates are stored permanently and are
accessed. You can initiate the Configuration Application for each 600 unit on the open map

The configurations of the remotes are launched from the HPOV Element Submap by first sel
a particular 600 remote unit, then choosing Configuration->Configure  from the Menu bar 
or from the Front Panel application Select  button menu. One main window and a set of transie
windows, offering unit optioning, make up this application. Included are the 600s configurati
(main widow), Unit Configuration Options, Alarms Reported, and All Screens.

Configuration - Main Window

The main window is comprised of four areas. The title bar provides the product name and 
configuration type. The name field contains the Shelf name, slot number and symbol label. 
menu bar provides file operations, navigation through subordinate screens and help. The ma
of the window is composed of administrative read-only fields. The status message area at th
bottom of the screen provides insight into the state of the application (See Figure 6-3). Note that the 
four 600s main window configuration screens are all very similar to each other, except that th
has two DTE card types, DTE1 and DTE2.
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Figure 6-3 Configurations for the Remotes - Main Window Screens

Table 6-4 Remote Units File Menu

File Menu

File -> Refresh Causes all options to be read from the unit; outstanding edits are lost.

File -> Save to Unit Causes all outstanding edits to be sent to the unit and saved.

File -> Load Template Allows the selection of an existing template of the remote units to be appli
as edits to the current application. (A subsequent File -> Save to 
Unit  operation implements the template changes.)

File -> Save to Template Causes the configuration data of a unit to be saved as a specific template

File -> Compare to Template Causes the template file data to be compared to the configuration screen 
and differences identified.

File -> Exit Causes outstanding edits to be discarded first and then terminates the ap
cation.
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Status Message . Status message area displays messages, describing application activity
unit interaction. Possible examples are: writing, saving to template, etc.

Unit Configuration Options

Their screens are shown when Navigate->Unit Configuration Options  is selected on 
the Configuration main windows of the remotes. This screen allows configuration of the maj
options of the unit (See Figure 6-4).

Table 6-5 Navigate Menu of the Remotes

Navigate Menu

Navigate -> Unit
Configuration Options

Displays the Options window.

Navigate -> Alarms Reported Displays the Alarms Reported/Thresholds  window.

Navigate -> All Screens Reads and displays all configuration screens.

Table 6-6 Help Option of the Remotes

Help Causes help to be displayed.

Table 6-7 Display Fields of the Remotes 

Fields
(Note that all fields on this screen are read-only.)

Name Shelf name, slot, and symbol label of the selected slot symbol from the sh
map

Slot State State of the shelf slot: active or inactive

Operational Status State of the current unit: up or down

Serial Number Unit serial number

Firmware Version Unit firmware version

MIB Version Unit Management Information Base (MIB) version

DTE Card

(Channel 1 or 2) (For 612 only)

Plug-in DTE type. Read-only types are V.35 or X.21.
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Figure 6-4 Unit Configuration Options Window Screens of the Remotes

Name is a read-only field.

Table 6-8 Configuration Options of the Remote Units

Unit Options

RTS CTS Delay Delay or no delay

RTS Normal  or force
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Alarms Reported

These screens are shown when Navigate->Alarms Reported  is selected on the 600 series
Configuration main windows (See Figure 6-5). Screens permit you to configure Alarm  reporting 
with thresholds. You can report or not report any individual alarm by selecting the alarm. A se
alarm means that the alarm is reported in an SNMP Trap from the SCM to the Controller. The
field is read-only.

DTE Rate 2400, 4800, 9600, 19200, 38400, 48000, 56000, 57600, 64000, 128000 bps
For the 610, 612, and the GT 128 only 64000 and 128000 bps are availa

RTS CTS Delay Time 0, 5, 10, 15, 20, 25, 30, 35, 40, 45, 50, 55, 60, 65, 70, 75 milliseconds

V.54 RDL Disable or Enable

621 and GT 128 Options

Rate Adaption X.50 Div2 or X.50 Div3 (621 only)

DTE Operation Async or Sync (621 only)

Word Length 8, 9, 10, or 11-bit word (621 only)

Overspeed 1 or 2.3% (621 only)

DCD Normal  or inband RTS (621 only)

RDL Timeout None or 10 minutes (option for the GT 128 also)

FP RDL Method PN127 or V.54 (option for the GT 128 also)

Action Buttons

OK Holds edits and dismisses the screen.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset and dismisses the screen.

Note: Defaults are in bold.

Table 6-9 Alarms of the Remote Units

Alarm Function

Channel 1 DTR Loss of DTR (DC610, 612, 621, or GT 128)

Channel 2 DTR Loss of DTR on DC612 Channel 2 (DC612 only)

Major Alarm BER Major alarm on Bit Error Rate (DC621 only)

Minor Alarm BER Minor alarm on Bit Error Rate (DC621 only)

Note: Threshold - (621 only) Major Alarm BER and Minor Alarm BER choices are 10-3, 10-4, 10-5, and 10-6.

Table 6-8 Configuration Options of the Remote Units
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Figure 6-5 Alarms Reported Screens of the Remote Units

Template Supports for the Remote Units

Device configurations are saved in a file and are known as templates, which can be applied si
to configure other units. You can Save , Load , or Compare  templates by accessing the File menu
and when you invoke one of these three operations, you see a dialog window where you are
to specify the template file name.

Alarm Detail

The remote unit Alarm Detail is launched from the HPOV Map Performance->Alarm  or from 
the Front Panel menu. The alarms for each 600 product are depicted on the screen, as sho
Figure 6-6. No DTR Present  alarm is only applicable if the GT 128 has a DTE type of V.35.

Table 6-10  Alarms of the Remote Units

Action Buttons

Report All Selects all alarms for reporting.

Report None Deselects all alarms, no alarms reported.

OK Holds edits and dismisses the screen.

Reset Undoes pending edits since last File->Save to Unit operation.

Cancel Same as Reset and dismisses the screen.
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No 
Figure 6-6 Alarm Detail Screens of the Remote Units

Reports

Description of the reports application is in Chapter 2.

Diagnostics

The diagnostic application is located in the 7616, 7626, 7624, 616, 613. or 611 application. 
diagnostic tests emanate from the 600 remote products.

Maintenance

Description of the reports application is in Chapter 4.

Information

Description of the reports application is in Chapter 2.
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